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INTRODUCTION TO MICROSOFT WORD

What is Word?

Word is the pre-eminent word processing program in use today.  You can use it for a quick letter to your landlord, to write your resume and term papers, or to write a reference manual hundreds of pages thick with table of contents, index, footnotes, and chapter headings, and in fact you can even use it to make web pages.  

Word is pretty easy to use in a naïve way – if you just crank it up and start typing you can make simple documents without much brain strain.  But such documents may not print the way you expect and they certainly won’t export as web pages the way you expect.  They will be difficult to maintain and update.  If you want to export to the web or do more complex documents, with page numbering, index, table of contents, footnotes, consistent styles and such; things will get rapidly out of hand unless you learn a few basics and approach your documents in an organized way.  

WHAT WILL I LEARN?

· Starting Word – with a blank document, from a template, or from an existing document.

· How to enter text – text wraps to the next line automatically (word wrap).
Enter ends a paragraph

· Navigating your document – Page Up, Page Dn, Home, End, Ctrl+Home, Ctrl+End

· Important formatting concept – character formatting vs. paragraph formatting
· Simple character formatting tricks – bold, italic, underline

· Simple paragraph formatting tricks:
line spacing, page break control, and…

left flush

right flush

centered

· More basic formatting – bullet list, numbered list, indenting, use of tabs
· Spell check, spelling and grammar feedback

· Using styles, headers/footers
· Normal View, Print Layout View (briefly other views – Outline, Web Page)
· Print…, Print Preview

· Quitting Word, the importance of saving frequently, knowing where your files are.

Editing an existing file

On your G: drive is a short poem badly in need of editing.  Recall from last week that G: is actually a directory on the College server Neutron.  

1. Bring up Windows Explorer 

2. Navigate to the comp110 folder on drive G:

3. Double-click the file poem.doc to open Word operating on this file.

Important notes on what we just did:  

The file you are editing is on the G: drive, which is read-only to you.  That means you cannot save your work to that drive.  In fact we are all editing from the same copy of the file!  We will each save the file to our own diskette when we are done.  We could have reversed the order of operations as follows:

1. Drag poem.doc from G: to your diskette

2. Double-click on A:poem.doc to edit it in Word.

This is quite a bit slower from your point of view, because Word will be saving your changes to the diskette drive rather than the hard drive.  
You will notice that Word presents a much more complicated interface than did Notepad.  There are more menus, there are intimidating looking toolbars, there is new stuff at the bottom of window, even the scroll bars are more complicated!
Basic Editing

Here is poem.doc:
"I here the wind amon g the tres

Playng Celestial symphonies;

I sea the branchess downward bent,

Like ke s of some great instrument.

First off, notice that Word has underlined parts of the text with squiggly red lines.  This tells you that Word thinks these words are misspelled.   

· Let’s try good old right-click on the last word of the first line -- tres.  The correct choice is of course, trees.

· If you see squiggly green lines, that means that Word doesn’t like your grammar.  Again, right-click to see Word’s suggestions.

· Let’s use the spell-checker to fix up the other items in bulk.  Locate in your toolbars the icon with ABC and a checkmark.

· First item highlighted is amon.  Let’s try clicking Change for this.  Hmmm, that left the trailing g.  Click Undo and instead, remove the space before the lone g.

· Continue on through the other words.

· As you can see, even after Spell Check is complete we’re got a couple of problems.  First, fix key s.

· The other problem is that see is misspelled, but the misspelling is also a legitimate word, so the spell-checker missed it!  Let’s fix that also.

saving your work

A really important thing when using Word or any computer program is:

Save your work early and often!

Remember Murphy’s Law – if something can go wrong it will – saving your work frequently is your best protection against all those things that can go wrong.  If you have a disaster but saved your work five minutes ago, you’re much better off than if you haven’t saved for three hours!  

This puts your newly edited file on your hard drive, and of course hard drives are also subject to the occasional disaster so there is the next step, of backing up the important files on your hard drive every now and then (one a month-ish for me).
Your poem should now look like the following, if it does not, use the tools just learned to fix it:

"I hear the wind among the trees

Playing celestial symphonies;

I see the branches downward bent,

      Like keys of some great instrument."

Make sure your diskette in drive A:, and choose the File/Save As… command.  
Tour the word user interface

Quite a bit of what you’ll learn here will apply directly to Excel and the other Office applications, as well as most other “well-behaved” Windows applications.

Menus:
· File – New, Open, Save, Print, recently used documents

· Edit – clipboard commands (cut/copy/paste), find and replace

· View – manage what you see on the screen, including toolbar control.  Generally, View commands do not affect the content of the document; rather they control what you see on the screen.  (For that reason I think header/footer control should not be here!)
· Insert – put special stuff into the document, including forced page breaks, and stuff from other programs.
· Format – tools for controlling the appearance of the document, style information.

· Tools – tools for managing the document – spell check, options dialog

· Table – tools for drawing tables

· Window – manage the window – Previous versions of Word used the MDI (Multiple Document Interface) style, now they do not.  So I think for instance, that you Windows 98 users will see a somewhat different interface.
· Help – come here when you don’t know what to do or how to do it.  Using the Office Assistant.
Toolbars:
By default we see just two toolbars:

· Standard – features the designers think are the most commonly used.  We will look at these one by one.  Print Preview, Spell Checker, Format Painter, and others.
· Formatting – most of the same features of the Format menu.

· Note that the View/Toolbars command lets you selectively turn toolbars on/off.

· Leaving the mouse arrow over a toolbar button shows its tool tip!

The rest of the Word window:
· At the bottom of the Word window is the Status Bar.  After you click on the document it shows a bunch of information about where you are in the document (total number of pages, which page you are on, etc.)
· Immediately above the status bar is a little row of buttons for quickly changing your view.  The four choices are Normal, Web Layout, Page Layout, and Outline.

· Word has horizontal and vertical scrollbars; the vertical bar has extra gizmos at the bottom.

· At the top of the view area, below the toolbars is the Paragraph Ruler, which tells you lots of stuff about the horizontal layout of the currently selected paragraph(s) of the document.  
· Tucked away at the upper right corner is the extremely useful split bar, which you can use to edit two parts of the document at the same time.

· I would like to also show you a couple of my favorite view tricks hidden away in the menus.  These tricks will help you understand formatting and perhaps help you understand why Word is doing what it does:
· Show the Style Area – Tools/Options/View tab/Style Area Width
· Show formatting marks – use Tools/Options/View tab/Formatting Marks to pick which marks to see all the time (I like Tab Marks and Paragraph Marks) and use the Show All command (Ctrl+*)
 to see ALL formatting marks.
Using dialog boxes:

Windows dialog boxes use a small set of standard graphical widgets to provide you the tools to specify what you want, and even better, there are standard ways to navigate around them.  First we will look at the Print dialog, because it is complex enough to show most of these features.  I will name the dialog widget, give an example, and describe its function:
· Checkbox – Print to file, Collate – click to check or uncheck it.  
On/off, true/false, yes/no, any situation with exactly two choices.  Note the cute visual feedback on the Collate checkbox!
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· Radio buttons – The buttons in the Page Range box – use this for more than two choices.  Only one button can be picked; a new choice turns off the previous choice.  The set of buttons should be visually distinct, as with the box drawn about them here.  
Note that this particular set of buttons has more complex behavior, as I will show.

· Combo box, also called a Pull-down Combo –Print what:, Print, etc. – pick from a set of choices.  Click the down arrow on the right to see all the choices.  Can be done with ratio buttons also, but this style is preferred when there are many choices or the choices can change.  Usually only one choice is allowed, but it is possible to have multiple choice combo boxes, where you use Ctrl+select to pick multiple items.

· Spin box – Number of copies: -- closely related to the combo box, you can type in a number or “spin” the counter with the little arrows on the right.  Note that you cannot exit this dialog without a valid non-zero number in this box!
· Dialog buttons – Options…, Find Printer… -- note that these end in ellipsis(…).  Do you remember that that means?  These all open subdialogs.
· Control buttons – OK, Cancel – it’s pretty standard that there be at least two buttons for closing any dialog, a “do it” button and a “don’t do it” button.  Here it’s OK and Cancel, on the Save As dialog, it’s Save and Cancel.  Using the keyboard, typically Enter means “do it”, Esc means “don’t do it”.
· Choosing Cancel means discard any changes you made.  The dialog will show the same initial settings it had before if you open it again.
· Choosing OK (or Save, etc.) means keep the changes.  The dialog will show the new settings if you open it again.
· On the Title Bar note the context help and close buttons – The Close button cancels the dialog.  Context help gives you a pop-up clue about the widget you choose.  Notice the change of the shape of the mouse arrow on Context help.
These dialogs are all modal, which means that you cannot do anything else in Word until you close the dialog.  Sub-dialogs are also modal; you cannot do anything in the parent dialog until you close the sub-dialog.  You can however click on other windows and work there.
Note as I mentioned before, that you can do everything in this dialog without using the mouse, using [Shift+]Tab to navigate, and space-bar, arrow keys and others to change values.

Now close the print dialog and bring up the incredibly complex Options dialog.  There is nothing new here in the way of widgets, just a lot more of them, but notice that this is a tabbed dialog – you can see different panes of choices by clicking on the tabs at the top.  From the keyboard you can navigate tabs with Ctrl[+Shift]+Tab.  This dialog is so complex that it has multiple rows of tabs, which I find quite confusing.  Again here, Cancel discards all changes to all panes in the dialog.  For that reason, many tabbed dialogs have a third button called Apply which lets you lock in some changes but stay in the dialog.

Editing a document

Getting around in a document:

We’ve discussed using the mouse and the scrollbars to get around.  Here are some keyboard navigation tricks:

· Home/End – move to the beginning/end of the current line.

· Ctrl+Home/Ctrl+End – move to the beginning/end of the entire document!

· Ctrl+left/right arrow –  jumps from word to word

· Ctrl+up/down arrow –  jumps paragraph to paragraph

Selecting text:

The area to the left of the lines of your document has special meaning here, and I am discovering that you can do some cool things with the Ctrl key.  Using the mouse, sometimes Word will annoyingly select a whole word when you want only part of the word, in that case you must use the Shift and the arrow keys to get what you want.
· Keyboard only:

· Hold down Shift key and change selection with arrow keys.

· Ctrl+Shift+left/right arrow adds words to the selection.

· Ctrl+Shift+up/down arrow adds paragraphs to the selection
· Hold down left mouse button and drag.

· Shift+click to select any range of text.

· Double-click to select a word.  
Ctrl+double-click will add other words to the selection.
· Ctrl+click to select a sentence. 
· Triple-click (!) to select a paragraph, or double-click to the left.
· Click to the left to select a single lines, Ctrl+click to add more lines to the selection.

· Ctrl+A to select all, or triple-click to the left.

Formatting a selection:

A fundamental concept is the difference between character formatting and paragraph formatting.  Character formatting can be applied to any sequence of characters, even one letter – it’s things like bold, italic, underline and different fonts.  Paragraph formatting applies to entire paragraphs, its application would not make sense on parts of a paragraph – centering, bulleted or numbered lists, and line spacing are all kinds of paragraph formatting.  If it’s not clear already, a paragraph in Word is ended with the Enter key.
Most of the common formatting operations can be done from the formatting toolbar and most also have shortcut keys, such as Ctrl+B for bold, Ctrl+U for underline, etc.

· Copying and pasting within Word copies the formatting information also.  This can get confusing if parts of your selection have different formatting.
· The Format Painter tool can be used to copy formatting from one selection to another (demonstrate).

· To see all the amazing variety of things you can do with Word formatting, look at the Format menu items.  We will look at these individually.

· You can give a name to a set of format settings and save it as a style.  Word comes with a number of pre-defined styles and you can certainly define more.  Styles are very powerful and can be complicated to use.
Using the Paragraph Ruler:
The ruler tells you about all the things listed here and lets you edit all but the margins for the selected text:  

· Margins

· First line indent

· Hanging indent

· Tabs – left, right, center

I use the ruler a lot to make nice multi-column lists.  This is a good time to emphasize the importance of using tabs properly (demonstrate).

Other random tricks:
· Finding text, replacing text, changing formatting with Find and Replace.
· Using Print Preview

· Using different views – Normal View, Page Layout View
· Line spacing – use line spacing rather than extra carriage returns to provide proper vertical spacing in your document. 
· Between paragraphs

· Within a paragraph

· Ctrl+Enter to force a page break

· Shift+Enter to force a new line but stay in the same paragraph.  
That’s what I did for this sentence!
· Using the Line and Page Breaks tab of the Paragraph dialog (Keep with Next, etc.) to solve page break issues.

· Copy the whole desktop to the clipboard with Print Scrn

· Copy just the current window (the one with focus) with Alt+Print Scrn.  This is how I grabbed the Print dialog above (demonstrate).
Headers and Footers
· Page numbers, total pages

· Date, time, file name

· Using the center and right tab markers (instead of the usual left tab)

· Going from header to footer

Using templates and wizards

In the next section you will make your own resume.  This will expose you to the wonderful world of templates and wizards.

You will find Templates and Wizards in all of the Microsoft Office Suite applications, and indeed all over Microsoft Windows.  There is for instance, a wizard to help you hook up to the Internet.  The fundamental problem is that Microsoft wants to give you -- the general, non-sophisticated user -- ever more sophisticated capabilities, but since you are by definition not sophisticated, you don’t have enough knowledge to use these capabilities without some guidance.  This is also why Windows and the Office Suite require so many gigabytes of your hard drive, for all the templates and wizards!
Templates are starter files, giving you the opportunity to start off with a professionally designed template for the kind of document you want to make rather than stumbling around on your own, so that you have at least a fighting chance of making something that is not too ugly.  
Wizards come into play if none of the templates available to you float your boat.  In that case there is a Wizard to lead you step by step towards a starting document that (one can only hope!) is close to what you want.
Make a resume

Our first actual, real assignment of this course will be to make a resume.  
From the previous discussion we now know that our best bet is to look for resume templates, and if that does not do the trick, we should look to the resume wizard.

You should take the rest of this class to work on your resume.  This document will be one of the key products of this course – we will print it, e-mail it as an attachment, save it as a web page, and even more things if I can think of them!  

making tables
Here is a simple table:

	Column 1
	Apples
	Oranges

	This is a fancy cell:

· Column 1

· Row 2
	Centered horizontally and vertically
	Bottom right corner


As you can see, Word has a whole menu devoted to tables, since they have a number of issues peculiar only to them.  In particular each cell of the table has all the formatting issues of a paragraph – alignment, spacing, etc.

I will use this example to demonstrate uses of the table menu.
Making web pages
Making tables is a good segue into making web pages, because as you will quickly find if you get into web design, web page layout of the last decade has been all about tables.  I will show you some tricks and then we will export your resume as a web page and save it to your diskette.

To save a Word document as any other kind of file, use the Save As… dialog (some other applications have a separate command called Export… on the File menu).  In the Save as type pull-down choose Web Page or Web Page, Filtered if you have it, and then notice that the extension of your file has changed from .doc to .htm.  Note that Word tends to make a bloated, kind of ugly html file, because Word wants to keep all the formatting formation in the file, even though html isn’t really intended for that. That is why they added the filtered option.
using outline view

Finally I will give you a quick introduction to Outline View, just so you know it’s there.  I love the idea of what it does, but I have always found it to be extremely frustrating to actually use – it’s always doing things to my document that I don’t want and conversely refuses to do what I do want!
Outline view is key to implementing large documents – chapters, table of contents that updates page numbers.  It operates off of special styles named Heading 1, Heading 2, etc.  It so happens that the titles used in this document use those styles, so I can so you a little bit about outline mode right here:

What you need to know from this lesson

· What does it mean if a menu label ends in “…”? (ellipsis).
· What’s the difference between character and paragraph formatting?  For example, can I apply line spacing to a word?  (no, that only makes sense for paragraphs).

· When selecting text with the mouse, what does the Ctrl key do?  (allows you to add more items to the selection)

� Note that since the asterisk {*) is over the “8” key, saying Ctrl+* is really the same as saying Ctrl+Shift+8.
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